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PowerSchool SIS: PowerTeacher Pro 
Gradebook 
PowerSchool's PowerTeacher Pro Gradebook is a robust classroom 
management tool that includes advanced features for both 
standards-based and traditional grading. Teachers use the mobile-
friendly gradebook to get their work done and to analyze student 
performance. 

Accessing the Gradebook 
Teachers navigate to the HTML-based gradebook directly through 
the PowerSchool SIS Teacher Portal. There’s no need to launch a 
separate application to access the gradebook. The first time you 
navigate to the gradebook, a welcome message appears 
introducing some of the features.  

To navigate to the gradebook: 

1. Enter the URL of the PowerSchool SIS server followed by 
/teachers 

2. Enter your username and password 

3. Select Sign In 

4. On the teacher portal Start Page, select PowerTeacher 
Pro 

5. Read the welcome message and select Close 
 
To view the message again, select the Help icon and select 
Getting Started. Also select the Help icon to access the 
PowerTeacher Pro Help system, and information about new 
features. 

Customizing Class Names and Adding 
Class Descriptions 
The gradebook includes read-only details about each class you 
teach, such as the course name, course number, section number, 
period, term, start date, end date, and associated grade scale. Add 
more details about the class, such as a description or the syllabus, 
that will be visible in the PowerSchool SIS Student and Parent 
Portals, and in PowerSchool Mobile. 

Also customize the name of the class if you prefer to use a name 
that is different from the course name. For example, if you teach 
multiple Biology classes, customize the names to be different from 
each other. Custom class names will appear only in your gradebook 
and are not visible to co-teachers, students, and parents. 

To customize a class name and add a description: 

1. At the top of the gradebook window, open the Class 
Selector menu and select a class 

2. Open the Term menu in the upper-right corner and select 
the term in which the class meets, if different from the 
current term, or select all terms 

3. In the main menu, select Settings 

4. Select Class Descriptions 
 
The details pane for the selected class opens. 

5. To customize the name of the class, enter the name in the 
Custom Class Name field 

6. Enter the class description, syllabus, or other details in the 
Class Description field 
 
You may copy and paste text into the description field. Use 
the editing bar to style, format, and add objects to the 
description. 
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7. Select the arrow to the left of another class name to open 
the details pane and add a custom name and description 

8. Select Save 

Setting Up Display Preferences 
Customize the display settings to control how class names appear 
in your gradebook—by period and day or by section number. 
Define whether to show standards and traditional grades and, if 
enabled, whether to limit the standards you can select to the 
lowest level of standards when creating assignments. Additionally, 
choose which gradebook page opens by default when you access 
PowerTeacher Pro. 

To set up display preferences: 

1. Select Settings 

2. Select Display Settings 

3. Open the Display and Sorting menu and select an option, 
such as Section Number (sort by Course/Custom 
Name), to change the way class names appear  
 
When you choose to sort class names by course name or 
custom name, classes will be sorted by their course names, 
unless you've entered custom class names on the Class 
Descriptions page. In that case, classes will be sorted by 
their custom names. 

4. Check Show Traditional Grades to display traditional 
grades in the gradebook 

5. Then open the Values to Show in the Traditional Grade 
Column menu, select the types of grades you want to 
display, such as Grade, Percent, and Points 

6. Check Show Standards Pages and Links to use the 
standards grading features in the gradebook 

7. Check Show Standards on Assignments to show 
standards aligned to assignments in the gradebook 

8. To limit the standards you can select when aligning 
standards to an assignment to only the lowest level 
standards, check Limit Assignment Standard Selection 
to Lowest Level 
 
Keep in mind that this feature is available only when it’s 
been enabled by school or district leaders and higher-level 
standards scores are set to be automatically calculated from 
lower-level standard scores. 

9. Open the Auto-Calculate Assignment Standards Scores 
Initial State menu and select New Assignments Start 
Checked 
 
Making this selection will cause the Auto-Calculate 
Assignments Standards Scores check box to be selected 
by default when you create an assignment.  

10. To change the sort order of the Traditional and Standards 
navigation links in the Grading menu and Quick Menu, open 
the Navigation Links Sort Order menu and choose 
Standards, Traditional 
 
The default setting is Traditional, Standards. 

11. To display the Professional Judgment Indicator on the 
Standards, Standards Progress, and Standards Scoresheet 
pages, check Show on Grading (Standards Final 
Grades) and Show on Students (Standards Progress, 
Standards Scoresheet) 

12. Under Student Names, open the Display menu to define 
how students’ names will appear in the gradebook, such as 
by first, then last name 
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13. Open the Sort Students by menu to choose how to sort 
the lists of students, such as by first name 

14. To place new students’ names at the bottom of class lists, 
check Add newly enrolled students to the bottom 

15. To conceal the names of pre-registered students from class 
lists, check Hide pre-registered students 

16. To choose the page that will be opened by default when you 
access the gradebook, open the Custom Starting Page 
menu and select a page, such as Scoresheet 
 
The default setting is Assignment List. 

17. Select Save 

Changing the Display Text Size 
PowerTeacher Pro Gradebook is designed to display multiple 
students or assignments in a compact view by default. However, 
you can zoom in by changing the text size. 

To change the size of the text: 

1. Select the User menu (a circle with your initials in it) in the 
upper-right corner 

2. Under View, select Medium or Large 
 
To decrease the text size to the default size, select Small. 

Setting Up Grading Preferences 
Administrators may choose to set up the grading preferences at 
the district or school level for all teachers. However, district and 
school leaders may permit teachers to define some of the grade 
calculations for the teachers’ own classes. Provided you have 
permission to do so, set up the grade calculations for one class. 
Then save time by copying the traditional grade calculations across 
classes and reporting terms. 

If you changed the default grade calculation formula set by the 
school or district, you can revert back to the default settings by 
selecting Revert to Default in the class heading. If the "Revert to 
Default" button is not there, that means you have not modified or 
have already reverted back to the default settings. 

Additionally, administrators may make alternate grade scales 
available for teachers and administrators to assign to individual 
students. If you have permission to do so, assign alternate grade 
scales to students who need to be graded using a grade scale 
that's different from the scale assigned to the class. For example, a 
student may have an IEP that specifies the use of an alternate 
grade scale.  

If administrators have given you permission to create or modify 
class grade scales, you may also edit the grade scales used by all 
of the students in one or more of your classes. 

Defining Traditional Grade Calculations 
To define a traditional grade calculation for a class: 

1. Select Settings 

2. Select Traditional Grade Calculations 

3. To display the grade calculations for all of the classes, select 
Expand All 
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4. For one of the classes in the list, select the Edit icon next to 
the first reporting term 

5. To calculate the overall class grade using the formula, verify 
that Calculate Overall Class Grade is checked 

6. Open the Type menu and choose a calculation type, such as 
Category Weighting 
 
If you want to use category weighting and your district 
leaders did not create categories for you to use, be sure to 
set up the categories first by following the instructions in 
the Creating Categories section of this document. 

7. Open the Attribute menu and select a category, such as 
Homework 

8. To define the weight of the selected category, enter a value 
in the Weight field, such as 2 (for 20%) 

9. To include another category, select the + sign 

10. Open the Type menu and choose Category Weighting 

11. Open the Attribute menu and select a different category, 
such as Quiz 

12. To define the weight of the selected category, enter a value 
in the Weight field, such as 3 (for 30%) 

13. Repeat steps 9-12 to set up weighting for two more 
categories 
 
Use weight values that allocate the correct percentage to 
each category. 

14. To save the grade calculation, select Save 
 
To complete the process, you would set up the grade 
calculations for the remaining reporting terms manually or 
by copying settings across reporting terms within a class, or 
from one class to another. 

To define a traditional grade calculation that includes specific 
weighting for course standards: 

1. Select Settings 

2. Select Traditional Grade Calculations 

3. To display the grade calculations for all of the classes, select 
Expand All 

4. For one of the classes in the list, select the Edit icon next to 
the first reporting term 

5. To calculate the overall class grade using the formula, verify 
that Calculate Overall Class Grade is checked 

6. Open the Type menu and choose Standards Weighting as 
the calculation type 

7. From the Attribute menu, choose Specific Weights 

8. Select the Specific Weights tab 

9. If your school or district leaders have enabled editing rights 
for you, modify the values in the Weight column to change 
the weight of course standards 
 
If you have not been given permission to edit the weights, 
you will be able to only view the specific weights set for the 
course at the district level. 

10. To save the changes, select Save 
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Defining Standards Grade Calculations 
To define standards grade calculations: 

1. Select Settings 

2. Select Standards Grade Calculations 

3. Define how standards grades will be calculated from 
assignment scores by default, for example, choose Most 
Recent Scores  

4. Define the number of recent scores to include in the 
calculation and their relative weighting by selecting the Edit 
icon, choosing the number of scores, and modifying the 
values in the Weight column 

5. To automatically calculate higher-level standards grades 
from lowest-level standards grades, check Auto-Calculate 

6. Select the metric that will be used in the calculation, such 
as Mean 

7. Select Save 

Copying Traditional Grade Calculations 
To copy traditional final grade calculations: 

1. Select Settings 

2. Select Traditional Grade Calculations 

3. In the upper-right corner of the Traditional Grade 
Calculations page, select the Gear icon 

4. Select Copy Traditional Grade Calculations 

5. At the top of the Copy Traditional Grade Calculations 
window, select Within A Class to copy the settings from 
one reporting term to another within the same class 

6. In the From Class area, open the Class menu and choose 
the class from which you want to copy the calculations 

7. Open the Reporting Term menu that appears and choose 
the term from which you want to copy the calculations, such 
as S1  

8. In the To Class area, open the Reporting Term menu and 
choose the term to which you want to copy the calculations, 
such as S2  
 
Select outside of the options to close the menu.  

9. If you are changing traditional grade calculation settings for 
the target class and want to recalculate any existing grades, 
check Recalculate Final Grades or clear the check box 

10. Select Validate 

11. Review the summary to ensure that you are copying the 
correct settings, then select Copy 
 
The alert at the top of the window indicates that the 
settings were copied successfully. 

Reverting to Default Calculation Settings 
To revert to the district or school default settings: 

1. Select Settings 

2. Select Traditional Grade Calculations or Standards 
Grade Calculations 

3. In the class heading(s), select Revert to Default 
 

 
The Revert to Default button will not be displayed after you 
revert to the default settings. 
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Assigning an Alternate Grade Scale to a 
Student 
To assign an alternate grade scale to an individual student: 

1. Select Settings 

2. Select Student Grade Scales 

3. Locate the section the student is enrolled in and select the 
arrow next to the section name 

4. To add a student grade scale, select Add 

5. From the Choose Grade Scale menu, select the alternate 
Pass/Fail grade scale 

6. Under Choose Students, check the box to the right of the 
student's name  

7. Select Save 

8. To confirm the change, select Save Changes 
 
New assignment scores that you enter for the student will 
be based on the alternate scale. To update previously 
entered scores, recalculate final grades by following the 
steps for recalculating final grades in this document. 

9. On the Student Grade scales page, view, modify, or remove 
grade scales assigned to individual students 
 
Note: When a student has been assigned an alternate grade 
scale, the Scoresheet will include a gold triangle in the 
name cell for that student. 
 

 

Creating and Modifying Class Grade Scales 
District or school administrators may give teachers permission to 
modify existing class grade scales or to create new ones for their 
classes. This provides the flexibility to accommodate various 
grading policies. 

If you choose to use the Class Grade Scale feature, it should be 
part of the setup at the beginning of the school year before class 
begins and before grades are entered. PowerSchool strongly 
recommends that this feature is not enabled or changed during the 
school year. 

If you have permission to do so, you can access and adjust class 
grade scales for your classes. You can edit the cutoff points, grade 
values, and color levels, and choose to ignore specific grades in the 
grade scales assigned to your classes. 

To create a custom grade scale: 

1. Select Settings  
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2. Select Class Grade Scales 
 
Select the arrow to the left of a class grade scale name to 
open the details pane. 
 
The Class Grade Scales page provides a user-friendly 
summary to review the grade scales assigned to classes, 
even when the custom grade scales feature is not used or 
enabled. 

3. Select Create Custom 
 
This option is available only if enabled and the feature is not 
locked as shown by the School Building icon and the term is 
not locked as indicated by the Lock icon. 

4. In the Custom Grade Scale window, enter a name for the 
custom grade scale and select the available classes to apply 
this custom grade scale 

5. Select Create 
 
The new grade scale will appear below the existing grade 
scale. 

6. Scroll down to the new grade scale and edit the cutoff and 
grade values, color levels, or choose grades to ignore  

7. Select Save 

After you create a custom grade scale, you can modify it by 
selecting Modify. You can change the name of the custom grade 
scale, apply it to more classes, delete it, or modify the cutoff and 
grade values, color levels, and ignored grades. Then select Save. 

Note that if you change or modify the class grade scale settings 
after grades are entered, you will be prompted with the option to 
recalculate the final grades for applicable classes. If you delete the 
custom grade scale after grades are entered, the deletion will force 
a recalculation of assignment scores and final grades for the 
associated sections and you will be prompted with a choice to 
proceed or not. 

Here are some additional points to keep in mind when using class 
grade scales: 

• Co-teachers can create class grade scales for their classes if 
they have edit access to the classes 

• Class grade scales do not roll over year to year 

• Only one class grade scale can be associated with a class 

Working with Student Groups 
Group students together to increase your ability to adapt 
instruction to students’ needs and to personalize learning. Create 
student groups for small group instruction, remediation, 
enrichment, or even non-academic purposes, such as groups based 
on parents' and guardians’ preferred contact methods.  

Using the student groups feature in PowerTeacher Pro, create 
groups of students across all of your sections for a given school 
year. Use student groups when you are creating assignments, 
reviewing pages, sending emails, and running reports. 

When you create student groups in PowerTeacher Pro, the 
information is stored in a cloud-based shared service instead of in 
the PowerSchool SIS database. 
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Creating Student Groups 
Set up student groups in the beginning of the year and add or 
remove group members throughout the year. Create additional 
groups as the year progresses to address specific student needs. 
You can even reuse student groups from year to year by setting 
them to never expire and modifying the students in those groups 
each year. Note that some of the related features are available 
only after you have set up a student group. 

To create a student group: 

1. Select the Create icon 

2. Select Groups 

3. In the Create Group window, on the Setup tab, first enter a 
unique name for the group 

4. Check the boxes next to the names of the students you 
want to include in the group  
 
Notice that the list of students includes all students in all 
your classes. To filter the list to specific students or 
students in specific classes, select the Gear icon and select 
Show Filter to open the filter. Enter the name of a class or 
student in the Basic Filter field and select Apply. To add 
another filter, select the + sign, select a filter option, enter 
or select another search term, and select Apply. 

5. Select the Options tab 

6. Enter a description of the group 

7. Define a start and end date 
 
The start date defaults to the current date and the end date 
defaults to the end of the selected school year.  

8. To create a group that you can reuse from year to year, 
check Group will not expire.  
 
Groups with no end date will never expire. 

9. In the Labels field, enter a label for the group that you can 
use to further describe and categorize the group, such as 
After-School Program 
 
For example, if you created a group named Remediation 
that you reuse year to year and you added students to the 
group in the current year based on their performance on a 
specific assessment, you could create a label with the 
assessment name as an indicator about why the students 
were added to the group.  

10. Select Add Label to create more labels for the group. 

11. Select Save 

Viewing and Modifying Student Groups 
To review, delete, or make changes to the student groups you've 
created, use the Student Groups page. Use the filter to find specific 
groups based on group names, students, and labels. Only groups 
that have a date range within the currently selected school year or 
those set to never expire are listed on the Student Groups page. 

To modify a student group: 

1. Select Settings 

2. Select Student Groups 

3. Select the Edit icon for the group you want to change 

4. Add or remove students and edit the group details 

5. Select Save 
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Working with Assignments 
Before you begin creating assignments, create categories so you 
can group and review assignments by type. When setting up 
assignments in the gradebook, choose whether to include them in 
the final grade, and whether to tie them to standards. Your district 
leaders may have already set up assignment categories at the 
district level for use in all schools. 

Creating Categories 
Categories are broad classifications in which you group similar 
types of assignments. Examples of categories are homework, tests, 
and quizzes. Set up your own categories, or use district-created 
categories. District-created categories are identified by a 
Schoolhouse icon next to the category name. 

 
To create an assignment category: 

1. Select the Create icon 

2. Select Category 

3. On the Category tab, open the Select Classes menu and 
select the class or classes in which you will use the category 
 
By default, the category is available for all of the classes 
you teach. 

4. Enter the name of the category, such as Test 

5. Select a color for the category, such as Red 

6. Use the default status of Active 
 
Check Inactive when you want to make categories that you 
no longer use inactive. 

7. Enter a description of the category, such as Use for test 
assignments 

8. Select the Assignment Defaults tab 

9. Use the Publish Assignment menu to define when 
assignments in this category will be published 

10. To publish the scores of assignments in this category by 
default, verify that Publish Scores is selected 

11. Select the default score type that assignments in this 
category will use, such as Points 

12. In the Score Entry Points field, enter the number of points 
that assignments in this category will be worth by default, 
such as 100 

13. To include extra points in the assignments by default, select 
Extra Points and enter the number of extra points, such as 
5 

14. To weight assignments in this category by default, select 
Weight and enter a value in the Weight field, such as 2 

15. To include assignments in this category in final grade 
calculations by default, verify that Count in Traditional 
Final Grade is selected 

16. To save the new category, select Save 
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Creating and Viewing Assignments 
Assignments are visible on both the Assignments and Scoresheet 
pages. Set up assignments at the beginning of a school term or at 
any time during the term. Create assignments for classes, student 
groups, or individual students. To save time, duplicate existing 
assignments or create duplicates while creating a new assignment. 
Keep in mind that when you create an assignment for students in a 
specific student group: 

• You must select the class(es) to which the assignment 
applies, in addition to the student group(s) 

• If a student is in multiple selected classes, then the 
assignment will appear for the student in each of the 
classes, and you can enter a score for each assignment 

• The group is not saved with the assignment, meaning if you 
add a student to the group after you've created the 
assignment, the student will not be added to the 
assignment automatically 
 
Add students who are new to the group to the assignment 
by editing the assignment and navigating to the Students 
tab. 

To create an assignment: 

1. Select the Create icon 

2. Select Assignment 

3. Open the Select Classes menu and select one class 
 
Select outside the Select Classes menu to close it. 

4. If you are assigning this assignment to students in a specific 
student group, open the Select Groups menu and select 
the group 
 
Select outside of the menu to close it. 

5. Enter the name of the assignment, such as Unit 1 Test 

6. Select Test as the category 

7. Use the default due date is today’s date 

8. Select a score type, such as Points 

9. Enter the number of score entry points, such as 80 

10. To include the assignment in students’ final grades, verify 
that Count in Traditional Final Grade is selected 

11. Enter a description, such as This test covers all of the 
topics in Unit 1 

12. Select the Students tab 

13. Verify that the assignment applies to all students, or if this 
assignment is for a student group, verify that the correct 
students are listed 
 
To apply the assignment to a selection of students, select 
Show All. Then clear the check box below the Filter area 
and check the boxes next to the names of a few students. 

14. Select the Standards tab, and make sure results from the 
Show All sub-tab are displayed 

15. Select the standards that are aligned to the assignment 
 
If you cannot select the higher-level standards, that means 
the feature used to limit assignment standard selection to 
the lowest level is enabled. 

16. Check Auto-Calculate Assignment Standards Scores 
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17. Select the Publish tab 

18. Open the Publish Assignment menu and choose when to 
publish the assignment for students, parents, and guardians 

19. To publish students’ scores once you’ve scored the 
assignment, check Publish Scores 

20. At the bottom of the Create window, select Save and Close 
 
Instead of closing the edit window, you could also copy the 
assignment by selecting Duplicate at the bottom of the 
Create window. 
 
Score the new assignment immediately by selecting Score 
Assignment in the alert at the top of the window. 
 

 
To edit an assignment: 

1. Select Grading and choose Assignment List 

2. Locate the assignment and select the Edit icon 

3. Modify the assignment details and save the assignment 

To duplicate an assignment for use in another class: 

1. Select Grading  

2. Select Assignment List 

3. In the list of assignments, locate an assignment that you’ve 
already created and select the Edit icon 

4. At the bottom of the Edit window, select Duplicate 

5. Open the Select Classes menu, clear the check box next to 
the currently selected class, and choose a different class 
 
Select outside the menu to close it. 

6. Edit the duplicated assignment name by deleting the 
underscore and number that were appended to the end 

7. Use the same category, due date, score type, score entry 
points, description, and publication settings as the original 
assignment, or modify the values as needed 

8. Select the Standards tab 

9. Select Show All and, if needed, select a new set of 
standards that are aligned to this assignment 

10. To save the assignment and close the Edit window, select 
Save and Close 

11. To verify that you copied the assignment to a different 
class, select the name of the currently selected class in the 
navigation bar at the top of the page and select the class 
that you copied the assignment to 

12. Locate the duplicated assignment in the list of assignments 

Copying Assignments 
As a lead teacher or a co-teacher, copy one, some, or all of the 
existing PowerTeacher Pro assignments in a selected term and 
class to other terms and classes using the Copy Assignments 
feature. Use the existing due dates, a custom due date, or 
proportional due dates relative to the selected term.  

If a Lock icon appears at the top of the assignment column, the 
reporting term or class is locked. You are unable to copy an 
assignment to a locked term or class. 

To copy assignments from a Semester 1 class to a Semester 2 
class: 
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1. From the Assignments or Scoresheet pages, select the Gear 
icon to the left of the Term menu 

2. Select Copy Assignments 

3. Under From Class, open the Term menu and select 
Semester 1 

4. Under From Class, open the Class menu and select the 
class from which you want to copy the assignments 

5. Under To Class, open the Term menu and select Semester 
2 

6. Under To Class, open the Classes menu and select the 
class or classes to which you want to copy the assignments 

7. Under Copy Options, open the Due Dates menu and choose 
whether you want to use existing, relational, or custom due 
dates 

8. Under Choose the Assignments, check the box to the left of 
the Category heading to select all of the assignments, or 
check individual boxes next to the assignment names to 
choose a smaller selection 
 
If the source class you selected is a PowerTeacher 
Gradebook class, all assignments will be copied to the 
classes you select. 

9. To complete the process, select Copy Assignments 
 
Be sure to edit the due dates of the copied assignments. 

Working with Grades 
When entering scores, make sure to use the type of score that you 
set up when you created the assignment. For example, use 
numbers for points and percentages or letters for letter grades. 

To enter scores: 

1. Select Grading 

2. Select Assignment List or Scoresheet 

3. From the Assignments or Scoresheet pages, enter a 
student’s assignment score by selecting in the cell where 
the student’s name intersects with the assignment name 
and enter the score  
 
Navigate sideways through the score columns by selecting 
the left- or right-facing arrows at the end of the rows.  
 
View the summary above the list of assignments to review 
the selected assignment’s score type, as well as the 
student’s existing score (if the assignment was previously 
scored), and the due date.  
 
In the summary, select Edit Assignment to edit the 
assignment details. Select Show More to view additional 
information, such as the associated grade and special codes 
scales. 
 

 
To view additional metrics for a selected assignment on the 
Assignments page, or for all assignments on the Scoresheet page: 

1. Select the Gear icon at the top of the page 

2. Select Show Metrics to view the mean, median, and mode 
statistics for the assignments or for the aligned standards 
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Using the Score Inspector and Flags 
While you can enter scores directly, use the Score Inspector to 
provide more details about the student’s performance, such as 
when a student has a missing or late assignment. Also use the 
Score Inspector to enter a comment about a student’s score.  

Your district leaders may have associated a special codes scale to 
the regular grade scale. If that is the case, you can select Codes in 
the Score Inspector and select a special code, such as NC for no 
credit, to score a student’s assignment. In some cases, you may 
also notice other system-generated icons that are related to 
standards grades. 

To open the Score Inspector, select a score cell on the Assignments 
or Scoresheet pages.  

The following table provides brief explanations of the flags (score 
indicators) and other icons available in the gradebook. 

Flag or Icon Description 
 

 

Indicates that an assignment was collected  

 

 

Indicates that an assignment is late 

 

 

Indicates that an assignment is missing 

Flag or Icon Description 
 

 

Indicates that an assignment is exempt 

 

 

Indicates that an assignment wasn’t completed 
due to the student being absent 

 

 

Indicates that an assignment is incomplete 

 

 

Indicates that a comment was added 

 

 

Indicates that evidence exists for mastery that 
may differ from a student’s calculated standard 
score 

 

 

Indicates that the standard grade is auto-
calculated from the lower-level standards scores 

 

 

Indicates that the assignment score is used to 
auto-calculate the scores for the standards 
aligned to the assignment 
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Filling Scores 
Use the Fill functions to either fill scores for one assignment for all 
of the students in a class or a student group, or to fill all 
assignment scores for one student. Scores and flags will be filled in 
cells that do not already have scores. Additionally, use the fill 
scores functions to fill comments. 

To fill students’ scores for one assignment: 

1. For the selected assignment, select a score cell on the 
Assignments or Scoresheet pages 

2. Enter the score or select the flag in the Score Inspector 

3. Select the Fill icon with the vertical arrows 

4. Save the scores 

To fill multiple assignment scores for one student: 

1. For the selected student, select a score cell on the 
Assignments or Scoresheet pages 

2. Enter the score or select the flag in the Score Inspector 

3. Select the Fill icon with the horizontal arrows 

4. Save the scores 

Adding Personal Comments to the Comment 
Bank 
Use the Comment Bank settings page to add personal (teacher-
created) comments to the comment bank to use when scoring 
assignments or adding final grade comments for report cards. Use 
smart text options to include names and pronouns in comments to 
personalize the comments for individual students. 

Also use the Comment Bank settings page to edit or delete 
personal comments, or to identify your favorite personal or district 
comments. To mark a comment as a favorite, select the Star next 
to a comment on either the My Comments or District Comments 
tab. Your favorite comments will appear at the top of the list of 
comments in the Score Inspector. 

To add a personal comment to the comment bank: 

1. Select Settings 

2. Select Comment Bank 

3. On the My Comments tab, select Add 

4. Enter a comment code, such as 01 
 
Comment codes are limited to 10 characters. 

5. Enter a comment category, such as Study Habits 
 
Comment categories are limited to 30 characters. 

6. To mark this comment as one of your favorites, check 
Favorite 

7. Open the Insert Smart Text menu and choose <first 
name> to insert it in the Comment field 

8. Enter the rest of the comment after the smart text, such as 
consistently completes homework on time 
 
Comments are limited to 500 characters. 

9. Select Save 
 
Your personal comment is listed on the Comment Bank 
setting page and will appear in the comment bank in the 
Score Inspector. 
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Entering Comments 
As you enter scores or indicators for assignments, use comments 
to record specific details about student performance. Add 
comments manually or choose comments from the comment bank. 
Select the Star icon next to a comment in the bank to set it as one 
of your favorite comments.  

To fill comments, enter a comment for one student and select the 
Fill icon. Then choose to fill comments only or to fill scores, flags, 
and comments.  

When you use the fill functions to fill comments that include the 
student’s name or any gender pronouns, PowerTeacher Pro detects 
this and you have the choice of applying the smart text to the 
comment for each student or using the original text. For example, 
if you enter a comment for one student that says, James 
completed all assignment tasks, fill the comment for other 
students, and select Use Smart Text, each student’s name will be 
personalized in the resulting comments. 

To enter a comment: 

1. Select the Comment icon in the Score Inspector 

2. Either enter a comment in the text box, or select Show 
Comment Bank  

3. Select the Gear icon and choose either the District 
Comments or My Comments bank 
 
Also choose to separate comments by a line break or a 
space. Select outside of the menu to close it. 

4. Select the + sign next to a comment to select it  
 
A blue Comment icon appears in the student’s score cell. 

5. Select Save 

6. Select the icon to read the comment 

7. Select Clear Comment to remove it from the score 

 

Scoring Assignments 
Use one of two methods to score an assignment—score a single 
assignment from the Assignments page, or score multiple 
assignments on the Scoresheet. 

To enter scores, flags, or comments for a single assignment: 

1. Select Grading 

2. Select Assignment List 

3. Select the name of an assignment 

4. Select the first student’s score cell and enter a score, such 
as 72 
 
Review the assignment summary above the list of students 
to determine which score type to use. 

5. Select the Comment icon in the Score Inspector 

6. Enter a comment, such as Needs to turn work in on time 

7. Select the right-facing Score arrow in the Score Inspector 
to move to a standards score cell  

8. Enter a standards score for the student 
 
Select Show More in the assignment summary above the 
list of students to determine which grade scale type to use. 
Hover your cursor over a standard identifier to display the 
name and description of the standard. 

9. Save the scores 
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To enter scores, flags, or comments for one or more assignments 
on the Scoresheet: 

1. Select Grading 

2. Select Scoresheet 

3. Select a student’s blank score cell for the selected 
assignment and enter a score in the Score Inspector 

4. Select the Vertical Fill icon to fill all of the blank score cells 
with the score you entered in the Score Inspector 

5. In the alert window that lists the number of scores that 
were filled, select Ok 

6. Select a different student’s score cell for a different 
assignment and select the Exempt flag 

7. Select Save 

When you delete or edit a score, a small gear icon appears next to 
the values in the student’s Grade column because they are being 
edited. Once you save the changes, the student’s grades will be 
recalculated using the new score. 

Using Minimum Assignment Values 
Some schools require a minimum grade value to be awarded for 
any assignment score. Use the Minimum Assignment Value 
functionality to force assignment scores assigned a traditional 
grade to be no lower than the minimum value, which is a 
percentage, regardless of the score entered by the teacher. If your 
school has set up this policy, when scoring assignments, you will 
notice both a max entry and min entry value. For example, if an 
assignment is worth 100 points and the minimum value has been 
set to 50%, the max entry is 100 and the minimum entry is 50. If 
you were to enter a score of 43 and select Save Scores, the value 
will automatically be entered in the scoresheet as 50.  

Auto-Calculated Assignment Standards 
When new standards are added to a previously graded assignment 
that has its standards auto-calculated, those new standards will 
have their scores auto-calculated. In versions prior to PowerSchool 
SIS 20.11, adding standards would not automatically impact the 
score and the scores would be blank.  

Within an assignment, on the Standards tab, the "Auto-Calculate 
Assignment Standards Scores" check box is selected. Clear the 
check box to remove this option if you don't want scores for the 
newly added standards to be auto-calculated. 

Previewing Grades 
There are times when you may want to preview how a particular 
score on an assignment will affect a student's final traditional 
and/or standards grades without having to save the scores. For 
example, a student may ask you what score they need to earn on a 
final exam to bring their grade up from a D+ to a C.  

In the gradebook, use the Preview Scores function on the 
Scoresheet, Standards Final Grades, All Reporting Terms, (student) 
Assignments, and Standards Scoresheet pages to preview how 
unsaved assignment scores will affect students' final grades. The 
Preview Grades button appears once a grade change is made, but 
not until then. 

To preview grade changes: 

1. Select Grading and select Scoresheet 

2. Locate the student and the assignment you want to work 
with 

3. Select the student's assignment cell and enter a grade or 
modify the existing grade 

4. Select Preview Grades 
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5. If there are existing standards scores, choose whether to 
adjust or keep the scores 

6. Review the changes to the student's final grade 
 
The cells that contain data that has changed are outlined in 
blue. 

7. To exit the preview and revert to the existing grade, select 
Cancel Preview 
 
No changes to the student's final grade will be made unless 
you select Save. 

Copying and Transferring Scores 
As a busy teacher, you can sometimes make mistakes like entering 
scores for the wrong assignment in your gradebook. Or, you may 
have students switch between two classes that you teach.  

Copying and Pasting Scores 
Fix score entry mistakes or transfer scores by copying and pasting 
scores or grades from one assignment to another, or from one 
class to another class with the same students in different reporting 
terms. Use the Assignments, Scoresheet, or Standards Grades 
pages to copy and paste scores or grades. However, keep the 
following rules in mind: 

• You cannot replace scores or grades that use a different 
score type than the original 

• When pasted to a column with different grade scales or total 
points, scores and grades are not converted to the new 
grade scales or total points 

• If the list of students is different between the original 
assignment scores and the assignment being copied to, only 
scores for students who are in both classes will be updated 

• You cannot paste into the assignment score column on the 
single assignment scoring page when an assignment is set 
to auto calculate standard scores 

• You are unable to copy scores and grades to a locked term 

To copy and paste scores or grades: 

1. On the Scoresheet or Standards Grades pages, select the 
assignment score column heading 

2. Choose Copy 

3. Locate the assignment you wish to paste to and select the 
score column header 

4. Then choose Paste 
 
All updated scores and grades are highlighted. 

5. Save the scores 

Transferring Scores 
When a student transfers into your class or moves between two 
sections of a class you teach after the term has started, you can 
copy the assignment scores from the student's dropped class into 
the new class. However, keep the following rules in mind: 

• Only assignments with scores for the selected student in the 
dropped class are available to be transferred  

• Assignment scores, standards scores, assignment 
comments, and assignment flags are saved as part of the 
transfer process 
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• Comments from the teacher who taught the dropped class 
will be listed with that teacher's name at the end of the 
comment 

• When transferring scores to an assignment using a different 
grade scale, percentages are copied, points are adjusted as 
needed, and letter grades are calculated based on the grade 
scale used by the student's new class 

To transfer assignment scores from a student's dropped class: 

1. Select Students 

2. Select the student who transferred into your class  
 
Students who enrolled in the class after the term's start 
date are labeled with "New student as of [date]" under their 
names. The label will be present for only two weeks from 
the student's class enrollment date. 

3. Open the Quick Menu and select Transfer Scores  
 
If you are viewing the student's Assignments page, select 
the Gear icon and choose Transfer Scores. 

4. To use the filter options to limit the number of assignments 
that appear on the page, select the Gear icon, select Show 
Filter, and use the filter options 

5. Open the From Class menu and select the dropped class 

6. Open the To Class menu and select the class you want to 
copy the scores to 

7. Open the From Term menu and select the term you want 
to transfer scores from 

8. Open the To Term menu and select the term you want to 
copy the scores to 

9. Use the To Class Assignment column to map the 
assignments  
 
If the assignment ID or assignment name matches between 
the From Class and To Class columns, the matching 
assignment appears in the To Class column automatically. 
 
If there are multiple assignment names that match between 
the From Class and To Class columns, but there is one 
unique due date match among the multiple exact name 
matches, the assignment with the matching due date 
appears in the To Class column automatically. 
 
If there are no matching IDs or names between the From 
Class and To Class columns, then no suggested assignment 
appears, but you can browse available assignments and 
select one to map the scores to. 

10. To view the details and any potential issues about the 
scores you are transferring, select Details 

11. To complete the process, select Transfer Scores 

Exporting and Importing Assignment Scores 
When you need to score an assignment offline, such as when you 
have a parent volunteer score an assignment, export the 
assignment into a spreadsheet. Then record the students' scores in 
the spreadsheet and use it to import the scores into PowerTeacher 
Pro. Also, export existing assignment scores to work with the data 
in a spreadsheet. If the reporting term or class is locked, you are 
unable to import scores. 

To export and import assignment scores: 

1. Select Grading 

2. Select Assignment List 
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3. Select the name of the assignment 

4. In the upper-right corner of the assignment page, select the 
Gear icon 

5. Select Export Scores Template 
 
If there are any existing assignment scores, choose whether 
or not to include the scores in the exported file by selecting 
Yes or No in the Export Scores Template window. 

6. Open the exported file 
 
The top of the spreadsheet includes the teacher's name, 
class, assignment name, due date, points possible, extra 
points, and score type. Below the assignment details are 
three columns—Student Number, Student Name, and Score. 

7. Enter the students' scores in the Score column and save the 
spreadsheet as a .csv file 

8. In the gradebook, navigate back to the assignment page, 
select the Gear icon, and select Import Scores 

9. In the Import Scores window, select Browse Files 

10. Select the spreadsheet file 

11. In the Format menu, use the default selection of 
PowerTeacher Score Template 

12. Check Validate Student Names to validate that the 
student names in the import file match the names of the 
students enrolled in the class 

13. Select Next 
 
Review and correct any import errors. 

14. To import and save the scores in the gradebook, select 
Import 

Working with Final Grades 
Final grades are updated automatically throughout the term as you 
enter assignment scores in the gradebook. When the term comes 
to a close, however, you may have additional tasks to perform 
before submitting grades for report cards to make sure that your 
final grades are accurate. For example, you may have to enter 
standards grades, modify individual scores, or enter citizenship 
grades. Occasionally, you may also need to modify a student’s final 
grade in a course based on effort, participation, or other 
performance factors.  

To work with final grades, select Grading and use the links in the 
Grades section. Access the same links by opening the Quick 
Menu—the arrow next to the heading at the top of the grading 
pages.  

 

Modifying Final Grades 
To modify a final grade: 

1. Select Grading 

2. Select Traditional 

3. Select a student’s final grade 
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4. In the Score Inspector, edit the student’s grade  
 
For example, change a letter grade of A- to A, and a 
percentage of 91 to 94. 

5. Select Save  
 
Notice that the student’s final grade cell has a small triangle 
in the upper-left corner, which indicates that the grade has 
been modified manually. 
 

 
6. Open the Quick Menu and select Standards 

7. Select a standards grade for the same student 

8. In the Score Inspector, select the Graph icon to open the 
read-only standards progress graph for the selected 
standard and student 

9. Select the Graph icon in the Score Inspector again to close 
the progress graph 

10. Using the Score Inspector, edit the student's final standards 
grade 
 
For example, change a score of 3 to 4 or a score of M to E. 

11. Select Save 
 
To revert to the calculated grade, select the Undo icon in 
the Score Inspector. To view additional standards metrics, 
select the Gear icon at the top of the page and then select 
Show Metrics to view the mean, median, and mode 
statistics. 

Viewing Dropped Students 
When working with final grades, if you need to review, modify the 
final grades for, or enter comments about the students who have 
dropped your class, do so from the Traditional grades page. 

To review dropped students: 

1. Select the class the student was in 

2. Select Grading 

3. Select Traditional 

4. Select the Gear icon and choose Show Dropped Students 

Entering Citizenship Scores 
If your school doesn't track behavior through standards, then your 
district leaders may enable citizenship score entry and set up a 
citizenship scale that includes codes like S for Satisfactory or N for 
Needs Improvement, for you to use in PowerTeacher Pro. 

To enter citizenship scores: 

1. Select Grading 

2. Select Traditional 

3. Select a student's cell in the Citizenship column 

4. In the Score Inspector, select a citizenship score, such as S 

5. Select Save 
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Awarding Variable Credit 
If you teach at a school that has an alternative education program 
or any sections in which students can earn variable credit hours for 
a course, your school administrator can set up PowerSchool SIS so 
that you can enter variable credit for students in PowerTeacher 
Pro.  

Using variable credit, teachers can specify how much credit each 
student attempted (potential credit) and how much credit each 
student is awarded (earned credit), regardless of the credit hours 
specified for the course or the grade the student earned for the 
class in a term.  

To enter awarded and attempted variable credit: 

1. Select Grading 

2. Select Traditional 

3. Select a student's cell in the Awarded column 

4. Enter the number of credits the student earned, such as .5 

5. Select the same student's cell in the Attempted column 

6. Enter the number of credits the student attempted, 
such as 1 

7. Select Save 

Note: If your school's transcripts include only awarded credit, then 
there will be only one column for entering the credit values in 
PowerTeacher Pro. 

Recalculating Assignment Scores and Final 
Grades 
Although grades in PowerTeacher Pro are calculated automatically, 
you can force a recalculation, if necessary. Use the recalculate tool 
after making significant changes in the gradebook, such as adding 
multiple assignment scores for students who transferred from 
another class. Also, recalculate scores and grades when your 
PowerSchool SIS administrator changes a setting that affects the 
gradebook, such as the grade calculation formula or grade scale, or 
when you assign an alternate grade scale to a student. 

To use the recalculate tool: 

1. Select Grading 

2. Select Traditional 
 
Or select Scoresheet, Standards, Comment Verification, 
Category Totals, or All Reporting Terms under Grading. 
Under Students, select Assignments, Standards Progress, or 
Comment Log. 

3. Select the Gear icon 

4. Select Recalculate Final Grades 

5. Select the classes in which you are recalculating grades 

6. To recalculate traditional grades, check Traditional Final 
Grades 

7. To recalculate standards scores, check Standards Final 
Grades 
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8. To update existing assignment scores, open the Advanced 
Options pane and check Refresh Assignment Scores 
 
The option to refresh assignment scores will include 
traditional, standards, or both types of scores depending on 
which types of final grades you choose to recalculate.  
 
Recalculate assignment scores only when your PowerSchool 
SIS administrator changes the grade scale.  
 
If you choose to recalculate final standards grades and 
standards grades are auto-calculated, be aware that any 
grades you've entered or changed manually will be 
overwritten. 

9. Select Recalculate 

Submitting Final Grades 
At the end of the term, notify your school’s PowerSchool SIS 
administrator that you have finished entering the scores for the 
term and that final grades are ready to be stored. 

1. Select a class and verify that you are in the correct term 

2. Select Grading 

3. Select Traditional 
 
Or select Standards or Comment Verification. 

4. At the bottom of the page, select Final Grade Status 

5. To indicate you have completed your final grades, check 
[Term] Final Grades are Complete 

6. Enter a comment indicating that final grades are complete 
and select Save 
 
The green check mark next to "Final Grade Status" indicates 
that final grades are complete. 
 

 
 
If you aren’t done with final grades yet, leave the check box 
clear, enter a status comment, and select Save. Remember 
to submit final grades for each class you teach. 

Understanding Locked Reporting Terms 
At the end of a reporting term, your PowerSchool SIS administrator 
may choose to lock the reporting term to prevent changes to 
grades so that the grades in teachers' gradebooks remain the same 
as the grades that have been stored in PowerSchool SIS and 
included on report cards. Your PowerSchool SIS administrator will 
define the dates on which reporting terms will be locked. Once a 
reporting term is locked, you will not be able to change final 
grades, assignment scores, or assignments that have been scored. 
Additionally, if you recalculate final grades, grades in any locked 
terms will not be recalculated. 

If your school or district leaders decide to lock reporting terms, you 
will notice warning messages at the top of PowerTeacher Pro 
pages, such as the Assignments and Scoresheet pages.  

• Before the reporting term is locked, a warning message will 
appear indicating when the reporting term will be locked 
 
For example, a message might indicate the reporting term 
will be locked in five days. Be sure to complete final grades 
before the end of the lock date.  
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• Once a reporting term has been locked, a message  will 
appear indicating that the term is locked 

If you attempt to score an assignment or a standard aligned to an 
assignment that has a due date in a locked term, you will also 
notice a message in the Score Inspector indicating that the score is 
locked. 

What if you need to correct a final grade after a term is locked? If 
you need to change assignment scores or final grades after a 
reporting term has been locked, contact your PowerSchool SIS 
administrator. Your administrator can temporarily unlock one or 
more of your classes so that you can make the necessary changes. 

Analyzing Performance 
Use the gradebook to analyze student performance at any time 
during the school year. Analyze performance throughout the term 
to ensure that students are mastering the skills and standards that 
you are teaching. Review students’ performance as you prepare to 
complete final grades for report cards, and then use the gradebook 
to prepare for and conduct parent-teacher conferences.  

Review how students in an entire class or in a specific student 
group are performing using the Progress pages. The individual 
student pages provide helpful information during parent-teacher 
conferences to explain why a student earned a particular grade. 

Student 
View Page 

Description 

Assignments Use the Assignments page to review a 
summary of a student’s grades and 
assignments for the selected reporting term. 
The Assignments student page is similar to 
the Assignments page you use for the entire 
class, except that it shows only the 
assignments and scores for the selected 
student. 

Standards 
Progress 

The Standards Progress page shows a 
student’s standards grades by reporting term. 
The column that corresponds to the selected 
term is highlighted. Compare the grades the 
student received in each term to assess their 
progress. To review the assignments that you 
used to assess the standard, select the icon in 
the Assignments column. Use the graph at the 
top of the page to track how the student 
performed over time on the standard. 

Standards 
Scoresheet 

Use the Standards Scoresheet to review a 
student's standards scores on all of the 
standards aligned to assignments for a 
reporting term on a single page. Or, select the 
Gear icon and select Show Filter to filter the 
list of assignments. The Standards Scoresheet 
is similar to the Student View in 
PowerTeacher Gradebook. 
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Student 
View Page 

Description 

Transfer 
Scores 

Use the Transfer Scores page to copy the 
assignment scores from a student's dropped 
class into a new class when that student 
transfers into your class or moves between 
two sections of a class you teach after the 
term has started. Scores from any term can 
be copied, even if the previous term is locked. 
Copy scores to any term, except to a locked 
term. 

Comment Log Use the Comment Log page to review all of 
the comments you’ve recorded for a student. 
Depending on the types of comments you’ve 
entered for the student, the comment log may 
show course grade comments, standards 
grades comments, and assignment 
comments. 

Observations Use the Observations page to review all of the 
observations you’ve created for the student. 
The Observations page displays the title, 
location, description, escalation status, and 
date of the observation. Select the Edit icon 
to modify the information for an observation. 

Assets and 
Textbooks 

Use the Assets and Textbooks page to review 
the list of assets associated with the student. 
The Assets and Textbooks page displays the 
asset title, the description, the check-out and 
return dates, and the status, such as In or 
Out. Associate an asset to the student by 
selecting Check In/Out. View the assets for 
the student’s other classes by selecting the 
Gear icon and selecting Show Classes 
Taught by Other Teachers.  

Student 
View Page 

Description 

Demographics Use the Demographics page to review a 
student’s personal information, such as their 
date of birth or mother’s phone number. 
Administrators may choose to set up 
PowerSchool SIS so that you can access the 
contact information from any student contacts 
associated with the selected student. 

Regardless of the district setting, some 
student contact data will be available in 
PowerTeacher Pro if the district has enabled 
the student contacts feature. This includes 
email addresses, phone numbers, employers, 
and original contact types, if set. Your 
administrators can enable other contact 
information. 

Quick Lookup 
- Traditional 

The traditional Quick Lookup page is the same 
page that administrators have access to in 
PowerSchool SIS. It shows the student’s 
attendance for the last two weeks, their 
current schedule and grades, a summary of 
their total absences and tardies, and their 
current GPA. Select a grade to review the 
grades and flags for the student’s 
assignments, as well as the standards score 
information. Select the Standards icon to 
display the standards aligned to an 
assignment. Parents, students, and 
administrators will also have access to this 
information for all PowerTeacher Pro sections. 
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Student 
View Page 

Description 

Quick Lookup 
- Standards 

To access a student’s standards Quick Lookup 
page, select Quick Lookup - Standards. 
Then select the arrow next to one of the 
student’s classes to display the standards 
aligned to the course and the student’s 
standards final grades. Select a standard final 
grade to review details about it. When a 
student is graded on the same standard in 
multiple classes, the student's final grades on 
that standard can be averaged into one final 
grade—review the standard grade rollup 
information on this page. 

PowerTeacher 
Portal 

Select PowerTeacher Portal to review the 
selected student’s screens in the teacher 
portal, which is opened in a new window so 
that you don’t lose your place in 
PowerTeacher Pro. The screen that appears 
depends on which screen you set up to be the 
default student screen in the teacher portal. 
For example, the student’s Schedule screen 
may appear. 

Viewing Individual Student Progress 
To review an individual student’s performance: 

1. At the top of the gradebook window, select a class or a 
student group 

2. Select Students 

3. To view the first student’s performance, select 
Assignments 

4. Review the student’s course grades and individual 
assignment scores, then open the Quick Menu and select 
Standards Progress 

5. Review the student’s standards scores for each reporting 
term, then select the Assignments icon for one of the 
standards 

6. Review the graph of standards scores, then select Show 
Metrics to review the student’s other standards statistics 
 

 
7. Select Students and select a different student to view their 

Standards Progress page 

As outlined in the "Working with Final Grades" section of this 
document, you can also access a student's Standards Progress 
graphs directly from the Standards page by selecting the student's 
standards grade, and then selecting the Graph icon in the Score 
Inspector. Using the Standards page to view progress graphs is 
useful when preparing for report cards. 

Here are the definitions of the standards scores statistics that are 
visible when you select Show Metrics below the graph: 

• Most Recent – The average of the most recent score(s) 

• Mean – The mathematical average of the scores 
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• Median – The middle of the scores (half of the scores are 
above this number and half are below) 

• Mode – The most common score achieved 

• Weighted Mean – The average of the scores based on the 
average of total weighted points 

• Highest – The highest score 

These statistical values are indicators of how well the student did 
on a specific standard. If any of the values are low, it may mean 
that the student needs additional practice on the skill or concept 
that you’re assessing, or you may need to revise the assignment. 
To review the student’s performance on additional standards, open 
the Quick Menu and select a standard. 

The orange Professional Judgment Indicator may appear next to a 
student’s standard score on the Standards Progress page when 
evidence exists for mastery that may differ from the student’s 
calculated standard score. To evaluate the student’s level of 
mastery, select the Assignments icon next to the standard score. 

 
Use your professional judgment to evaluate whether the calculated 
score is a true indication of the student’s level of mastery. For 
example, if the student was ill or had a bad test day, the last score 
may not be a true indicator of skill level, so you could choose to 
ignore that score and change the calculated score. 

Graphing Additional Standards or Metrics 
To compare a student’s progress on up to four standards: 

1. Select the Gear icon next to the term menu on the 
Standards Progress page  

2. Select Progress Options  

3. In the Progress Options window, select the standards you 
want to include in the comparison and select OK 

4. Then, select the Show/Hide Graphs icon next to the Gear 
icon to display the student’s progress on all of the selected 
standards  

5. Select one of the symbols, such as a triangle, on one of the 
line graphs for a different standard to highlight it and view 
the scores 

6. Below the graph, review the calculated standard grades, the 
metrics, the aligned assignments, and the scores for the 
standards included in the comparison 
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By default, the Standards Progress graph displays a green dotted 
line that corresponds to the metric, such as Most Recent, used in 
the standards grade calculation.  

To add additional metrics to the graph: 

1. Select the Gear icon next to the term menu on the 
Standards Progress page  

2. Select Progress Options  

3. In the Progress Options window, open the Additional 
Metric To Graph menu and select a metric, such as 
Highest 

4. Select OK 
 
A gray dotted line appears on the graph, indicating the 
score that corresponds to the selected metric. 

 

Analyzing Class Progress 
To analyze the performance of an entire class or that of a student 
group, begin by selecting the class or student group at the top of 
the gradebook window. Then, select Progress. Depending on how 
the gradebook is set up, you can analyze class progress on 
traditional grades and standards grades. 
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Viewing Traditional Grades Progress 
To review traditional grades progress: 

1. From the Progress menu, select Traditional 
 
The graph on the Traditional Grades Progress page shows 
the distribution of grades for the class for the selected 
reporting term. The horizontal black line shows where the 
cutoff is between passing and failing grades. Select the 
Information (i) icon to display the traditional grades 
included in each color level. To the right of the graph, view 
a summary of the total number of students who have 
missing, late, or incomplete assignments. 
 

 
2. Select View All to open the Traditional Grades Distribution 

window 

3. On the left side of the Traditional Grades Distribution 
window, review the grade distribution for each reporting 
term in the school year 

4. On the right, view the grade trends of the students in the 
class for the selected term, compared to the previous term 
 
A red arrow in the Grade column indicates that the student’s 
grade is trending down between the selected terms. A green 
arrow indicates an upward trend, while no arrow indicates 
no change. Review which students are performing better or 
worse between terms. 

5. To compare trends between a different selection of 
subsequent terms, select a term in the Grade Distribution 
column 

6. Select the Information (i) icon to view the grades included 
in each color level 

7. To close the window, select X in the upper-right corner 
 

 



PowerSchool SIS: PowerTeacher Pro Gradebook 
Quick Reference Card 

Copyright © 2023 PowerSchool or its affiliates. All rights reserved. 29 

Viewing Standards Grades Progress 
To review standards grades progress: 

1. From the Progress menu, select Standards  
 
The graph on the Standards Progress page shows the 
distribution of grades for each standard aligned to the 
course, for the selected class and reporting term. The black 
line shows where the cutoff is between passing and failing 
grades. 

 
2. Select a graph to open the Standard Grades Distribution 

window 

3. On the left side of the Standard Grades Distribution window, 
notice the grade distribution for the selected standard for 
each reporting term in the school year 

4. On the right, review the grade trends of the students in the 
class for the selected term, compared to the previous term 
 
A red arrow in the Grade column indicates that the student’s 
level of mastery is trending down between the selected 
terms. A green arrow indicates an upward trend, while no 
arrow indicates no change.  

5. To compare trends between a different selection of 
subsequent terms, select a term in the Grade Distribution 
column 

6. To close the window, select X in the upper-right corner 
 

 
On the right side of the Standards Progress page, the number in 
the Assignments column indicates the number of assignments that 
you’ve used to give students opportunities to practice the standard 
or to assess their levels of mastery.  

To review the assignments aligned to a standard: 

1. Select the Assignments icon next to a standard 
 

 
2. On the Standards Assignment Trend window, select the 

name of an assignment 
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3. If needed, edit students’ scores in the column for the 
selected standard and save the scores 

Using Class Functions 
Use the gradebook to take care of some regular class functions, 
like recording observations about your students and tracking their 
assets and textbooks. 

Recording Student Observations 
Create observations as a way to record notes about students that 
you can use to help in student performance analysis, such as 
semester reviews.  

To add an observation:  

1. Select the Create icon 

2. Select Observation  

3. Enter a title for the observation, such as Improved 
Participation Skills 

4. Open the Student menu and select a student  
 
The menu will include all students you teach, not just the 
ones in the class you were working with on the previous 
page.  

5. Enter the location 

6. Enter the date and time of the observation, or use the 
default values of the current date and time 

7. Enter a description of the observation 

8. To submit the observation for review by an administrator, 
check Escalate for review by administration  
 
This option may not be available, depending on your 
school’s settings. When this setting is checked, the 
observation will be read-only, the information will become 
part of a teacher referral incident for administrators to view 
in PowerSchool SIS, and the reviewing administrator will 
receive a notification of the observation.  

9. Select Save 

Access and edit the observations you create by selecting Class and 
then selecting Observations. Change the selected class or group 
at the top of the page to access their observations. Access the 
observations for a student using the Students menu, or, when 
reviewing a student page, using the Student View menu and 
selecting Observations. 

Managing Assets and Textbooks 
Manage the distribution of textbooks and other assets by checking 
the materials in or out. Review and edit asset information at the 
class or individual student level.  

Managing Assets at the Class Level 
To manage assets at the class level:  

1. Select Class 

2. Select Assets and Textbooks 

3. Select a class or group from the menu at the top of the 
page to access their assets and the check-in/check-out 
status  

4. To record that a student has possession of an asset, select 
Check In/Out  

5. Select the student from the menu  
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6. Enter the asset tag, such as the textbook number  
 
If configured, you can also scan asset tags. 

7. Open the Condition When Checked Out menu and select 
an option, such as Lightly Used 

8. Add any notes about the terms of the checkout or the 
condition of the asset  

9. Select Check Out 

Managing Assets at the Student Level 
To manage assets for an individual student:  

1. Select Students  

2. Select Assets and Textbooks 

3. To view the assets associated with other teachers, select 
the Gear icon and select Show Classes Taught by Other 
Teachers 

4. To check in an asset, select Check In/Out 

5. Enter or scan the asset tag 

6. Update the condition of the asset and add notes  

7. Select Check In 

Communicating with Students and 
Contacts 
If your district has enabled the email option in PowerSchool SIS, 
then you can communicate with your students and their contacts 
while reviewing assignments and grades. Keep in mind that emails 
are sent to only students and contacts who have email addresses 
listed in PowerSchool SIS and that emails are sent to only a 
contact's primary email address. Also note that this feature should 
not be used to communicate information related to student safety. 

Emailing Students and Contacts 
Send emails to your students and their contacts from within 
PowerTeacher Pro to share information. Keep in mind that emails 
can contain only plain text. If you need to send your students and 
their contacts attachments, use the Copy Emails function to copy 
the email addresses into a different email client. 

The Create Email window also includes filter options you can use to 
select specific students and contacts, such as only students and 
their parents or guardians. To show or hide the filter, select the 
Gear icon. 

Filter types include: 

• Type – Student and Contacts options 

• Email – Has Email and No Email options 

• Contact Type – Father, Mother, Guardian/Has Custody, 
Emergency Contact, Receives Mail, and School Pickup  

• Name – Search field  

To send emails to students and/or contacts: 

1. Select the Create icon 

2. Choose Email 
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3. On the Recipients tab, verify that you are working in the 
Select by Classes tab  

4. Open the Select Classes menu and select the class or 
classes 
 
To send the email to students in a specific student group(s) 
and their contacts, choose the Select by Groups tab, open 
the Student Groups menu, and select the group(s). Select 
outside of the menu to close it. 

5. If needed, select the Gear icon and select Show Filter to 
filter the recipient list 

6. To select all of the students in the selected class(es), check 
the box at the top of the Students column, or select 
individual students using the check boxes 

7. To select all of the associated contacts, check the box at the 
top of the Contacts column, or select individual contacts 
using the check boxes 
 
Contacts are listed under the associated student's name in 
the list of recipients, in the order in which they appear in 
PowerSchool SIS (ex: the primary contact is first). 
 
If you need to send an attachment, select Copy Emails, 
and then paste the emails into a different email client that 
you can use to send attachments. 

8. Select the Message tab 

9. Enter the subject of the email 

10. In the Message text box, enter the body of your email 
message 

11. Check CC Me to send a copy of the message to yourself 

12. Select Send 

Running PowerTeacher Pro Reports 
The gradebook contains reports that you can review onscreen or 
print. Run each report by selecting Reports, selecting the report 
name, and defining the report criteria and formatting options. 
Personalize each report by entering a custom title or by including a 
top note, bottom note, or signature line. The following table 
provides brief descriptions of the reports: 

Report 
Name Description 

Final Grades 
Report 

• Use this report to print and validate 
your final grades and comments for 
your classes or student groups for the 
selected term before submitting grades 
to an administrator 

• Use this report when an administrator 
requires you to submit a signed final 
grade and comments verification report 
during the End of Term process 

• Include a signature line, points, 
percentages, grades, and/or comments 

• Run the report as a PDF or an Excel 
spreadsheet 
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Report 
Name Description 

Individual 
Student 
Report 

• Use this report to review or print a 
summary of the class or student group 
activity per student 

• Include only one class or create a 
"multi-section" report by including the 
student's full schedule 

• Generate a report similar to the Multi-
Section Report in PowerTeacher 
Gradebook that includes scores for any 
course a student or a whole class is 
taking 

• Include student numbers next to 
student names for identification 
purposes 

• Present a summary of student work to 
parents at conferences or to a principal 
during a review, or use the report as a 
midterm update for students and 
parents 

• Choose whether or not to include 
course grades and attendance, 
assignments, category totals, 
standards scores, citizenship scores, 
and comments 

• Print the report for a few students or a 
group 

Report 
Name Description 

Missing 
Assignment 
Report 

• Use this report to create lists of 
assignments that have not been 
scored, have been marked with the 
Missing flag, or have a score of zero 

• Run the report for a selected term by 
class, by student group, or by student 

• Run the report as a PDF or an Excel 
spreadsheet 

Multi-Function 
Assignment 
Report 

• Use this report to review or print a list 
of students and scores per assignment 

• Use it to find missing, late, or 
incomplete assignments, to help 
students and parents keep up with 
class work, to target students who 
need extra help, or to gauge which 
assignments present the most 
challenges to students 

• Run the report for a selected term by 
class, by student group, or by student 
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Report 
Name Description 

Scoresheet 
Report 

• Use this report to print a copy of the 
Scoresheet page 

• Include final grades and assignment 
scores 

• Use student numbers or names 

• Sort students by name, student 
number, or randomly 

• Use it to post a printout of students' 
grades 

• Run the report for a selected term by 
class, by student group, or by student 

• Run the report as a PDF or an Excel 
spreadsheet 

Standards 
Grades Report 

• Run this report to generate a 
spreadsheet-style summary of 
standards grades earned by students in 
your classes or student groups 

• Review standards grades for all 
reporting terms and assignments that 
are within a specific date range, for all 
students 

• Include the standard identifier, name, 
or both 

• Run the report as a PDF or an Excel 
spreadsheet 

• Note: You can run the By Assignment 
option for only one class at a time 

Report 
Name Description 

Student 
Roster 

• Use this report to review or print 
demographic information by class or 
student groups 

• Use the report to keep track of money 
collected for classroom field trips, or as 
an emergency contact list, for example 

• Customize the report by adding blank 
columns (the report retains the 
information you entered last) 

• Use the Order arrows to arrange the 
columns in any order 

• Run the report as a PDF or an Excel 
spreadsheet 

Using the Report Queue 
Navigate to the Report Queue to access and manage reports you've 
generated. Access the Report Queue in either the Navigation menu 
by selecting Reports and then selecting Report Queue or by 
selecting the Notifications icon and selecting Report Queue.  

Reports in the queue are listed by name and date. The icons in the 
Status column indicate whether a report is running, pending, 
completed, cancelled, or if there was an error. Refer to the legend 
for icon definitions. 

To download a report, select the report name. To delete a report, 
select the Delete icon in the Actions column. To rerun a report 
using the same settings you used to run the original version, select 
the Details icon (looks like an "i") in the Actions column, then 
select Resubmit. To update the status of a running or pending 
report, select Refresh. 
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Running the Individual Student Report 
To run the Individual Student Report: 

1. Select Reports 

2. Select Individual Student Report 

3. Enter a report title, such as Progress Report 

4. Open the Classes menu and choose the classes to include 
on the report 
 
To run the report for one or more student groups, open the 
Groups menu and select the group(s). 

5. You don't want to print custom class names on the progress 
reports for parents, so verify that the Use Custom Class 
Name check box is not selected 

6. Since the progress reports are for your classes only, rather 
than for all of the students' classes, verify that the Include 
Student's Full Schedule check box is not selected 

7. To generate each student's report as a separate file, check 
Separate Report By Section, By Student 

8. In the Sort Options section, open the Layout menu and 
choose By Section, By Student 

9. To sort the report by students’ last names, open the 
Students menu and choose Last Name 
 
To use the preference for how student names are sorted by 
default in your gradebook, choose Gradebook Preference. 

10. Use the Assignments menu to sort the assignments by due 
date or by category and due date; for example, choose Due 
Date (Newest First) to list the assignments by the most 
recent due dates 

11. In the Data section, open the Areas To Include menu and 
check Course Grade Comments and Assignment 
Comments to include any comments you’ve entered about 
the students in the report, then select the menu name again 
to close it 
 
"Course Grades and Attendance," Standards Final Grades, 
Assignments, and Category Totals are checked by default. If 
citizenship score entry is enabled, select Citizenship to 
include citizenship scores. 

12. Verify that Show Percentages is selected to include 
students’ grade percentages in the report 

13. To include any assignments that have no grade data, such 
as those that haven't been scored yet, check Show 
Assignments with no Data 

14. To include the standards identifiers for standards final 
grades, check Include Standards Identifier 

15. To help with identifying students with the same name, add 
student numbers next to student names in the report 
header by selecting Include Student Number with 
Student Name 

16. In the Date Range section, use the default settings to 
include students’ grades, assignments, and category totals 
from the current term  
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17. In the Date Filters section, use the default settings to 
include any assignments, any scores, any category, and any 
course grades 

18. Scroll to the top of the page and select the Students tab 

19. To run the report for a selection of students rather than for 
all of the students in the classes, select Add/Remove 
Students 

20. All of the students are selected by default, so clear the 
check box to the right of the Filter area, then check the 
boxes next to the struggling students’ names 
 
For the purposes of this activity, pick a few students at 
random. 

21. Scroll to the top of the page and select the Format tab 

22. Since you are including all of the available data in the 
report, leave the page orientation set to Landscape to 
make the text easier to read 

23. Use the default option PDF for the report output 

24. To create a page break between students, check Page 
Break 

25. Choose to exclude row shading to save ink during printing 

26. Leave the “Include” check box clear for the Top Note option, 
since you don’t plan to include a note at the top of the 
report 

27. Since you are meeting the student’s parents in person, you 
don't need a signature line, so also leave the “Include” 
check box clear for the Bottom Note option 

28. To generate the report, select Run Report 
 
An alert at the top of the window indicates that the report is 
being processed. 

29. To open the Report Queue, select View Reports 

30. If the report is still running, select Refresh to update the 
status 

31. To download the completed report, select the report name 
 
Depending on how your computer is configured, the report 
will be saved as a download or it will open in your browser. 
The report may also be downloaded as a zipped file. Now 
you can print the reports to share them with parents. 

 

 

Running the Missing Assignment Report 
To run the Missing Assignment Report by student: 

1. Open the menu at the top of the gradebook window and 
select a class 

2. Select Reports 
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3. Select Missing Assignment Report 

4. Enter a report title, such as S2 Missing Assignments 

5. Since you selected a class before you navigated to the 
Reports menu, use the class that is already selected for the 
Classes option 

6. To include both the students' names and student numbers 
in the report, open the Student Field menu and select 
Both 

7. Under Sort Options, open the Layout menu to choose By 
Student so that the report will include one page per 
student (rather than one page of all of the students who are 
missing assignments in the class) 

8. To sort the report by students' last names, open the 
Students menu and choose Last Name 

9. To sort the list of missing assignments included in the 
report by the most recent due date first, open the 
Assignments menu under Sort Options and choose Due 
Date (Newest First) 

10. Under Data, open the Assignments menu and select to 
include assignments that have not been scored, ones you've 
marked with the Missing flag, or those with a score of zero 

11. For the Categories menu, use the default selection to 
include all categories of assignments in the report 

12. Under Date Range, open the Assignments menu and select 
S2 to include missing assignments from Semester 2 

13. Select the Students tab at the top of the page and verify 
that the report applies to all of the students in the selected 
class 

14. Select the Format tab 

15. Open the Orientation menu and choose Landscape  

16. Use the default option PDF for the report output 
 
To work with the data in a spreadsheet, choose Excel.  

17. Use the default settings for the rest of the format options 

18. To generate the report, select Run Report 
 
An alert at the top of the window indicates that the report is 
being processed. 

19. To open the Report Queue, select View Reports 

20. If the report is still running, select Refresh to update the 
status 

21. To download the completed report, select the report name 

 

 

Running the Student Roster Report 
To run the Student Roster report for a class: 

1. Open the menu at the top of the gradebook window and 
select the class or a student group 

2. Select Reports 

3. Select Student Roster 

4. Enter a report title, such as Field Trip Roster 

5. Since you selected a class or student group before you 
navigated to the Reports menu, use the class or group that 
is already selected for the Classes and Groups options 
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6. If you've customized the names of your classes and want to 
use the custom names in the report, check Use Custom 
Class Name 

7. To sort the roster of students by last name, open the 
Students menu and choose Last Name 

8. Add columns of student information by opening the Add 
Columns menu next to Student Columns and selecting Add 
next to Gender and Grade Level 

9. Select Add next to Blank twice to include a column for 
taking attendance and one for tracking participation 
 
A column titled “Name” is included by default to list the 
students’ names. 

10. Select the Add Columns menu again to close it 

11. Enter Attendance as the title of the first blank column 

12. Enter Participation as the title of the second blank column 

13. Add columns of contact information by opening the Add 
Columns menu next to Contact Columns and selecting Add 
next to Contact Name and Contact Phone 
 
Note that the contact options are determined by the district-
level settings. 

14. Select the Add Columns menu again to close it 

15. Open the Filter Contacts menu and select the contact 
type, if desired 

16. Scroll to the top of the page and select the Students tab 

17. Verify that the report applies to all of the students in the 
selected class 

18. Scroll to the top of the page and select the Format tab 

19. Open the Orientation menu and choose Portrait  

20. Use the default option PDF for the report output 
 
To work with the data in a spreadsheet, choose Excel. 

21. Use the default settings for the rest of the format options 

22. To generate the report, select Run Report 

23. To open the Report Queue, select View Reports 

24. If the report is still running, select Refresh to update the 
status 

25. To download the completed report, select the report name 
 
Depending on how your computer is configured, the report 
will be saved as a download or it will open in your browser. 
Now you can print the report and take it with you on the 
field trip. 

 

 


